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BAB I. PENDAHULUAN 

 
 

1.1 Deskripsi 

dapat dijadikan panduan didalam memecahkan soal lainnya dan langkah-langkah 

pemecahan soal tersebut dengan alat bantu program SAP2000. 

1.2 Kompetensi yang dikembangkan 

1. Mengetahui konsep cara kerja semua jenis struktur 

2. Mengetahui gaya yang dihasilkan akibat beban luar yang telah ditentukan 

3. Dapat membandingkan hasil pengujian antara hitungan manual dengan SAP2000 

1.3 Waktu Pelaksanaan 

Praktikum ini dilaksanakan selama 9 minggu dimulai pada minggu ke 3 

perkuliahan sampai dengan minggu ke 12 perkuliahan dengan jadwal praktikum 

yang sudah ditentukan sesuai kelas masing masing. 

1.4 Tata Tertib Praktikum 

1. Wajib memakai jas laboratorium. 

2. Wajib memakai alat pelindung diri berikut ini: 

• Sepatu 

• Masker 

• Sarung tangan 

• Sepatu boot (untuk kegiatan tertentu) 

3. Wajib menggunakan hand sanitizer setiap memasuki laboratorium. 

4. Ketika masuk dan keluar laboratorium wajib sesuai jalur sirkulasi laboratorium. 

5. Wajib mencuci tangan sebelum memulai praktikum (apabila pemeriksaan 

menggunakan bahan habis pakai tertentu). 

6. Semua bahan habis pakai adalah penting, sehingga harus ditangani dengan 

prosedural dan hati-hati. 

7. Semua bahan kimia harus dianggap berbahaya, oleh karena itu harus ditangani 

dengan prosedural dan hati-hati. 

8. Tidak diperbolehkan makan, minum dan merokok selama kegiatan di dalam 

laboratorium. 
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9. Tidak diperbolehkan makan, minum dan merokok selama kegiatan di dalam 

laboratorium. 

10. Tidak menyentuh mulut dan mata pada saat sedang bekerja. 

11. Tidak diperbolehkan menyimpan makanan di dalam lemari laboratorium yang 

digunakan untuk menyimpan bahan-bahan laboratorium. 

12. Membersihkan semua peralatan bekas pakai dengan alat dan sabun cuci yang 

disediakan. 

13. Membersihkan permukaan tempat bekerja atau meja kerja. 

14. Menggunakan sarung tangan rumah tangga sewaktu membersihkan alat-alat 

laboratorium dari bahan gelas. 

15. Mencuci tangan dengan sabun (dan desinfektan jika perlu) setiap kali selesai 

bekerja. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
 

Menurut Frick (1978) ilmu statika adalah ilmu tentang semua benda yang 

tetap, yang statis, semua yang tidak bergerak (atau yang tidak akan bergerak). Lain 

halnya dengan ilmu dinamika yaitu ilmu tentang semua yang bergerak. Kedua ilmu 

tersebut mempunyai dua persamaan, yaitu gaya-gaya dan pergerakan. Hanya bahwa 

dalam ilmu statika kita hanya bekerja dengan gaya-gaya yang tidak bergerak, 

dengan keadaan pergerakan sama dengan nol (v = 0). Hal ini dapat terjadi apabila 

semua gaya yang membebani suatu benda dan gaya-gaya pada tangkai pengungkit 

(dengan jarak antara gaya dan benda = momen) saling menutupi, sehingga semua 

gaya seimbang. Oleh sebab itu ilmu statika juga disebut ilmu keseimbangan gaya 

atau dengan singkat ilmu keseimbangan. 

Statika merupakan ilmu yang mempelajari kesetimbangan gaya, dimana gaya- 

gaya tersebut dalam keadaan diam (kesetimbangan suatu struktur). Ilmu statika 

bermanfaat untuk mengetahui gaya-gaya yang bekerja dalam suatu struktur yang 

berguna dalam perancangan struktur tersebut. 

 

Agar dapat menerapkan prinsip-prinsip statika pada suatu sistem, maka 

struktur tersebut harus dalam keadaan setimbang. Hal ini dapat dipenuhi jika jumlah 

semua gaya meliputi beban-beban kerja dan reaksi perletakan (reaksi tumpuan) 

adalah sama dengan nol. Selain itu harus terpenuhi pula bahwa jumlah momen- 

momen gaya terhadap suatu titik adalah sama dengan nol (Setiawan, 2015). Sistem 

gaya-gaya yang bekerja pada struktur akan seimbang apabila memenuhi syarat 

keseimbangan statik, yaitu: 

Ketiga syarat kesetimbangan tersebut disebut dengan tiga persamaan 

dasar kesetimbangan. 
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BAB II. PRINSIP DASAR STATIKA 

2.1.   Pengertian Umum 

2.1.1.  Persamaan Kesetimbangan 

a. (ΣH=0) Tidak bergerak dalam arah horizontal, (2.1) 

b. (ΣV=0) Tidak bergerak dalam arah vertikal, dan (2.2) 

c. (ΣM=0) Tidak berputar. (2.3) 
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Dalam ilmu analisis struktur dikenal sistem statis tertentu dan statis tak tentu. 

Suatu sistem struktur dikategorikan sebagai sistem statis tertentu apabila semua 

gaya dalam dan reaksi pada tumpuan-tumpuannya dapat dihitung dengan persamaan 

Persyaratan suatu struktur dikatakan struktur statis tertentu dapat ditulis: 

Keterangan: 

n = jumlah batang 

i = jumlah reaksi tumpuan 

j = jumlah titik kumpul (joint) 

Contoh: 

Contoh 1 
 

 
Gambar 2.1 Contoh 1 

Balok pada gambar diatas memiliki j = 2, n = 1, dan i = 3, maka: 

3n+i =3(1)+(3)=6 

3j = 3(2) =6 

Sehingga, struktur diatas merupakan strukur statis tertentu karena 3n+i = 3j. 

Contoh 2 

Gambar 2.2 Contoh 2 

Balok pada gambar diatas memiliki j =2, n =1, dan i =4, maka: 

3n+i =3(1)+(4)=7 

3j = 3(2) =6 

 
Sehingga, struktur diatas merupakan strukur statis tak tentu karena 3n+r > 3j. 

2.1.2.  Perbedaan Struktur Statis Tertentu dan Tak tentu 

persamaan (2.4 ) 

kesetimbangan yang ada (persamaan 2.1, 2.2, dan 2.3). 
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Menurut Setiawan (2015) semua beban yang bekerja pada struktur pada 

akhirnya akan dipikul oleh tumpuan. Ada beberapa jenis tumpuan yang akan sering 

dijumpai dalam suatu proses analisis strutur. Masing-masing jenis tumpuan 

mempunyai karakteristik yang berbeda-beda. 

 

Tumpuan rol hanya dapat menahan gaya dalam arah tegak lurus (vertikal) 

saja dan tidak mampu menahan momen. Jadi tumpuan rol hanya mempunyai satu 

gaya reaksi yang tegak lurus dengan Rol. 

 

Gambar 2.3 Tumpuan rol pada jembatan 

 

Tumpuan sendi ini dapat menerima gaya dari segala arah tetapi tidak mampu 

menahan momen, sehingga tumpuan jenis ini hanya mampu berotasi. Dengan 

demikian, tumpuan sendi mempunyai dua gaya reaksi. 

 

Gambar 2.4 Tumpuan sendi pada jembatan 

2.2.    Jenis-jenis Tumpuan 

2.2.1.  Tumpuan Rol 

2.2.2.   Tumpuan Sendi 
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Tumpuan Jepit dapat menahan gaya dalam segala arah (baik vertikal maupun 

horizontal) dan dapat menahan momen. Jenis tumpuan ini tidak mengalami rotasi dan 

translasi, sehingga sering juga disebut tumpuan kaku (rigid). Dengan demikian 

tumpuan jepit mempunyai tiga gaya reaksi. 

 
Gambar 2.5 Tumpuan jepit pada bangunan 

 
 

2.3.  Gaya pada Struktur 

Gaya merupakan suatu sebab yang mengubah suatu benda yang tadinya diam 

menjadi bergerak atau dari bergerak menjadi diam. Gaya termasuk dalam besaran 

vektor, yaitu memiliki nilai dan arah. Dalam statika, gaya dapat diartikan sebagai 

muatan yang bekerja pada struktur. 

Momen gaya juga merupakan salah satu besaran yang penting dalam ilmu 

analisis struktur. Menurut Setiawan (2015) momen gaya terhadap suatu titik disebut 

sebagai hasil kali gaya dengan jarak tegak lurusnya ke titik tersebut, dapat bernilai 

positif atau negatif tergantung dari perjanjian tanda yang digunakan dalam analisis. 

 

Gaya luar merupakan gaya-gaya yang bekerja di luar struktur 

(muatan/beban). Gaya-gaya tersebut timbul pada struktur diakibatkan oleh adanya 

beban-beban layan yang bekerja pada struktur tersebut. Macam-macam beban yang 

umum dijumpai pada suatu system struktur diatur dalam SNI 1727:2020 tentang 

2.2.3.  Tumpuan Jepit 

2.3.1.  Gaya Luar 
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beban desain minimum dan kriteria terkait untuk bangunan gedung dan struktur lain. 

Beban-beban tersebut diantaranya adalah beban mati, beban hidup, beban angin, dan 

beban gempa. 

Pembebanan-pembebanan tersebut secara umum dibedakan menjadi dua 

jenis berdasarkan permukaan bidang tekannya, yaitu: 

2.3.1.1. Beban Titik 

Beban titik atau beban terpusat adalah beban yang bekerja pada suatu titik. 

Satuan yang dipakai biasanya adalah kilogram (kg), ton (T), Newton (N), kilo 

Newton (kN), dsb. Contoh dalam kehidupan nyata seperti berat seseorang melalui 

kaki, atau berat kolom pada pondasi. 

 

 
 

Gambar 2.6 Beban titik 
2.3.1.2. Beban Merata 

 

Beban Merata adalah beban yang bekerja merata dalam suatu panjang atau 

luas tertentu. Satuan yang biasa dipakai adalah kg/m, kg/cm, N/m. Ada 2 macam 

beban merata yaitu: 

a. Beban merata berbentuk persegi panjang 

Contoh dalam kehidupan nyata seperti berat sekelompok orang pada suatu 

ruangan, berat sloof pada pondasi. 

 

 
Gambar 2.7 Beban merata persegi panjang 
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Rumus resultan gayanya dapat ditulis. 
 

 

R adalah resultan gaya dan letak R melalui titik berat persegi panjang. 

b. Beban merata berbentuk segitiga 

Contoh dalam kehidupan nyata yaitu tekanan hidrostatik air pada 

dinding. 

Gambar 2.8 Beban merata berbentuk segitiga 

Rumus resultan gayanya dapat ditulis. 

R adalah resultan gaya dan letak R melalui titik berat segitiga. 

 

Reaksi perletakan atau reaksi tumpuan adalah reaksi pada suatu tumpuan 

yang timbul akibat adanya gaya luar yang bekerja, sehingga terjadi kesetimbangan. 

Setimbang merupakan kondisi yang tidak bergerak, sehingga struktur dalam 

keadaan stabil. Untuk menghitung reaksi perletakan, digunakan tiga persamaan 

ada. 

Perjanjian tanda untuk menghitung reaksi perletakan: 

a. Gaya horizontal 

Ke kanan ( ) bernilai positif (+) 

Ke kiri ( ) bernilai negatif (-) 

b. Gaya vertikal 

Ke atas ( ) bernilai positif (+) 

Ke bawah ( ) bernilai negatif (-) 

R =q.L 

2.3.2.  Reaksi Perletakan 

Persamaan (2.5) 

                                Persamaan (2.6) 

dasar kesetimbangan (persamaan 2.1, 2.2, dan 2.3) dan persamaan tambahan jika 
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c. Momen 

Searah jarum jam, bernilai positif (+) 

Berlawanan arah jarum jam, bernilai negatif (-) 

 

Gaya dalam merupakan gaya yang timbul di dalam suatu benda atau struktur 

akibat bekerjanya gaya luar. Menurut Megson (2005) suatu struktur dapat 

mengalami gaya yang rumit, tetapi gaya-gaya yang dialami struktur tersebut dapat 

terbagi menjadi empat jenis pembebanan dasar, yaitu gaya normal/gaya aksial, 

beban geser, momen lentur, dan torsi. 

Pada praktikum statika ini kita hanya membahas tentang gaya normal, gaya 

geser, dan momen lentur beserta penggambaran diagram gaya dalamnya. 

Pembahasan tentang torsi akan dibahas di mata kuliah lainnya. Penggambaran 

diagram gaya dalam untuk yang bernilai positif, diagram diarsir tegak lurus, dan 

yang bernilai negatif di arsir sejajar dengan sumbu batang. 

 

2.3.3.1.  Gaya Normal / Axial Force 

Menurut Megson (2005) Gaya normal adalah gaya yang sejajar dengan 

sumbu memanjang batang. Apabila gaya tersebut cenderung menimbulkan sifat 

tarik (meningkatkan panjang batang) maka batang tersebut mengalami tarikan dan 

diberi arah panah ke luar sumbu memanjang batang (bertanda positif). 

Gambar 2.9 Gaya normal yang menimbulkan tarik 

2.3.3.  Gaya Dalam 
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Sedangkan apabila gaya tersebut cenderung menimbulkan sifat desak 

(memendekkan panjang batang) maka batang tersebut mengalami desakan dan 

diberi arah panah ke dalam sumbu memanjang batang (bertanda negatif). 

 

 

Gambar 2.10 Gaya normal yang menimbulkan desak/tekan 

 
 

Besarnya gaya normal sepanjang batang selanjutnya digambarkan dalam 

bentuk diagram gaya normal/normal force diagram (NFD) Satuan gaya normal 

biasanya dinyatakan dalam kilogram (kg), ton (T), Newton (N), kilo Newton (kN), 

dsb. 

2.3.3.2.  Gaya Geser / Shear Force 

Menurut Setiawan (2015) gaya geser adalah gaya yang tegak lurus 

(vertikal) dengan sumbu memanjang batang. Gaya vertikal tersebut dapat terdiri dari 

reaksi tumpuan dan beban yang bekerja. Besarnya gaya geser sepanjang batang 

selanjutnya digambarkan dalam bentuk diagram gaya geser/shear force diagram 

(SFD). Tanda positif digunakan jika resultan gaya geser dari tinjauan sebelah kiri 

mempunyai arah ke atas. Satuan gaya geser biasanya dinyatakan dalam kilogram 

(kg), ton (T), Newton (N), kilo Newton (kN), dsb. 

2.3.3.3 Momen Lentur 

Menurut Soemono (1978) untuk memenuhi syarat keseimbangan, momen 

gaya diantara kedua ujung batang harus sama besarnya serta arah kerjanya 

berlawanan. Sumbu memanjang batang yang semula lurus akan membentuk garis 
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lengkung yang cembung (konvex) ke bawah atau cekung (konkaf) ke atas. Kejadian 

ini disebut lentur. Sehingga momen lentur adalah momen gaya yang menyebabkan 

struktur menjadi lengkung/bengkok. 

 

 

Gambar 2.11 Momen lentur yang membengkokkan batang 

 
 

Selanjutnya momen lentur di sepanjang bentang dapat menggambarkan 

diagram momen lentur/bending moment diagram (BMD). Momen lentur bernilai 

positif apabila momen tersebut menghasilkan tegangan tarik pada serat bawah 

terluar dari balok. Nilai maksimum momen lentur terjadi pada saat gaya geser 

momen lentur biasanya dinyatakan dalam kilogram meter (kgm), ton meter (tm), 

Newton meter (Nm), kilo Newton meter (kNm), dsb. 

bernilai nol seperti yang ditunjukan oleh gambar 2.12 (Setiawan, 2015). Satuan 
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Gambar 2.12 Gaya geser dan momen lentur pada balok 
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Menurut Setiawan (2015) apabila 3 gaya sebidang bekerja pada suatu struktur 

yang berada dalam keadaan setimbang, ketiga buah gaya tersebut akan membentuk 

segitiga gaya. 

pada satu titik tangkap. Jika pangkal dari gaya F2 diletakkan pada ujung dari gaya 

F1, gaya F3 yang berasal dari ujung F2 dan bertemu dengan pangkal dari F1 disebut 

tadi diletakkan pada pangkal F1, sedangkan ujung F3 diletakkan pada ujung F2 

 
 

Gambar 2.13 Konsep Segitiga Gaya 
 

 

Besarnya gaya resultan F3 dapat dihitung menggunakan persamaan berikut: 

Atau dengan menggunakan aturan trigonometri, diperoleh hubungan: 

Secara garis besar, struktur dibedakan menjadi tiga berdasarkan prinsip 

pemikul gaya yang dilakukan oleh masing-masing tipe yaitu struktur balok, struktur 

Pada Gambar 2.13 ditunjukkan tiga buah gaya sebidang yang saling bertemu 

sebagai gaya penyeimbang (lihat Gambar 2.13 yang b). Apabila pangkal gaya F3 

(Gambar 2.13 yang c), maka F3 disebut sebagai resultan dari F1dan F2. 

       persamaan (2.7) 

              Persamaan (2.8) 

2.4.    Segitiga Gaya 

2.5.   Tipe-tipe Struktur 
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rangka, dan struktur portal (Setiawan, 2015). Tipe struktur yang akan ditinjau 

dalam praktikum ini adalah struktur balok dan struktur rangka secara dua dimensi. 

 

Struktur balok merupakan elemen struktur paling sederhana yang banyak 

digunakan sebagai pemikul beban. Balok merupakan suatu batang dengan bentang 

tertentu dan terdapat tumpuan di salah satu ujungnya atau di beberapa titik (joint). 

 

Gambar 2.14 Contoh struktur balok sederhana pada jembatan 
 

 

Gambar 2.15 Contoh struktur balok kantilever pada kanopi 

2.5.1.    Struktur Balok 
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Struktur rangka (truss) terdiri dari beberapa batang yang saling terhubung 

sehingga membentuk elemen-elemen segitiga. Masing-masing hanya memikul gaya 

aksial. 

 

Gambar 2.16 Jembatan Kretek Yogyakarta struktur rangka (Truss) 3 dimensi 

Sumber: Dokumentasi Pribadi 

2.5.2.  Struktur Rangka (Truss) 



 

 

BAB III. PROGRAM SAP2000 

 
 

Pada perhitungan struktur yang kompleks dan rumit perlu adanya alat bantu 

hitungan untuk mempermudah pengerjaan dan memperkecil resiko kesalahan. Alat 

bantu yang dimaksud di sini tidak lain lain adalah program komputer dengan 

kemampuan dan fasilitas yang mampu mengerjakan perhitungan seperti pada 

hitungan manual dengan cepat dan tepat. Berapapun jumlah bentangan atau jumlah 

lantai akan ditangani dengan mudah dengan proses perhitungan lewat komputer. 

Salah satu program yang sangat popular di bidang analisis struktur adalah SAP2000.  

SAP2000 yang merupakan singkatan dari Structural Analysis Program 2000 

adalah program aplikasi komputer yang digunakan untuk menganalisis dan 

mendesain suatu struktur yang berorientasi obyek (Object Oriented Programing). 

SAP2000 merupakan program yang berasal dari Universitas of California at 

Berkeley, USA sekitar tahun 1970. Dari tahun ketahun SAP mengalami 

perkembangan yang cukup berarti, dari SAP yang under DOS hingga sekarang 

sudah sampai ke SAP yang under window. Untuk melayani keperluan komersial 

dari program SAP, pada tahun 1975 dibentuklah perusahaan komputer yang diberi 

nama CSi (Komputer and Structure,Inc). Perusahaan ini dipimpin oleh Ashraf 

Habibullah, yang sampai sekarang masih tetap eksis dan berkembang. Jika ingin 

mengetahui lebih lanjut perusahaan ini anda dapat mengunjungi situs 

(http://www.csiberkeley.com). 

Suatu catatan penting yang patut di ketahui dan dipahami bahwa secanggih 

apapun program komputer, keputusan tetap ada di tangan manusia yang 

memakainya, apakah model sudah mampu mencerminkan kondisi sebenarnya, 

karena yang perlu diingat adalah program tersebut hanyalah alat bantu saja. Oleh 

karena itu, walaupun telah ada program untuk mambantu dalam perhitungan analisis 

struktur, diharapkan pemakainya telah memahami konsep dari perhitungan dan 

perancangan itu sendiri. 

 

 

 
14 

3.1. Pengenalan Program 

http://www.csiberkeley.com/
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Program SAP2000 yang digunakan dalam praktikum ini adalah SAP2000 v14.1. 

Sebelum memulai menggunakan program SAP2000, terlebih dahulu harus dipahami 

dasar-dasar dari program tersebut, sehingga akan dihasilkan output yang sesuai dengan 

harapan. 

Beberapa tool yang ada dalam program beserta penjelasannya sebagai 

berikut: 

Gambar 3.1 Tampilan program SAP2000 

a. Menu Perintah 

 

Baris ini berisi kumpulan perintah-perintah yang tersaji dalam bentuk menu dan 

sub-menu. Menu dikelompokkan menurut fungsinya, misalnya pada menu File untuk 

menangani permasalahn pada File, seperti open, save, dll; menu Edit untuk melakukan 

perubahan data dll. 

b. Menu Perintah (Toolbar) 

Toolbar mempunyai fungsi yang sama dengan menu perintah, tetapi digunakan 

hanya dengan 1 kali klik pada tombol yang sesuai dan perintah langsung dijalankan. 

3.2. Dasar-dasar Program 

3.2.1.   Layar Tampilan SAP2000 
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c. Layar (Window) 

Merupakan tempat ditampilkanya model struktur, termasuk data input 

maupun data output dalam bentuk grafis. Dapat dikondisikan sesuai kebutuhan. 

d. Elemen Batang (frame) 

Elemen frame merupakan model pada SAP2000 yang berupa batang/garis 1 

dimensi pada arah panjang saja. Tipe penampang dan material dapat diubah 

sesuai kebutuhan, misal penampang persegi (balok), I (profil baja) dan lain- lain. 

e. Element Tumpuan (Restraint) dan joint 

Joint merupakan elemen nodal pada SAP2000, yang lazimnya terdapat pada 

tiap ujung elemen (frame, area, solid) namun dapat pula ditambahkan pada 

tempat-tempat lain. 

Restraint merupakan element joint yang mewakili kondisi tumpuan 

(support) seperti sendi, rol, atau jepit. Tumpuan lain disesuaikan dengan 

keperluan, dapat pula tergantung arah dan jenis kekangan tumpuan, termasuk 

spring (pegas). 

f. Indikator sumbu global (X-Y-Z) 

Indikator ini menjadi alat bantu penunjuk bidang gambar yang aktif. Pada 

tampilan perspektif 3 dimensi, semua sumbu akan terlihat, sedangkan pada 

tampilan 2 dimensi, hanya terlihat 2 sumbu. 

g. Gridline (garis bantu) 

Gridline merupakan garis-garis yang tampak di layar sebagai bantuan dalam 

penggambaran model struktur. Fungsinya mirip seperti kertas millimeter dimana 

garis-garisnya hanya sebagai garis bantu saja. Gridline tidak berpengaruh 

terhadap hasil analisis struktur. 

h. Baris Status 

Pada bagian kiri bawah layar SAP2000 akan terlihat baris ini, yang 

tampilannya berubah-ubah sesuai perintah yang dikerjakan. 

i. Indikator Koordinat Kursor 

Pada baris ini selalu tampil koordinat kursor (panah penunjuk) dalam 3 

dimensi, yang mengacu pada sumbu-sumbu koordinat yang ada. 
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j. Indikator satuan yang digunakan 

Pada bagian kanan bawah latar SAP2000 terlihat indikator satuan yang 

sedang aktif (satuan gaya, satuan panjang dan satuan suhu). Semua input dan 

output akan memakai satuan yang dipilih pada bagian ini. 

Dalam program SAP2000, digunakan 2 sistem koordinat yang biasa dipakai, 

yaitu: 

a. sistem koordinat cartesian, berupa bidang ruang datar/kotak sumbu x-y-z, 

b. sistem koordinat cylindrical, berupa bidang ruang melingkar/silindris sumbu r- 

θ-z. 

2.2.1.1. Sumbu Global dan Sumbu Lokal 

Pada SAP2000 dikenal istilah 2 macam sumbu: 

a. Sumbu global 
 

Sistem koordinat Global terdiri dari 3 sumbu, X, Y, dan Z yang saling tegak 

lurus sesuai dengan aturan "kaidah tangan kanan", dalam SAP 2000 selalu 

mengasumsikan sumbu Z arahnya vertikal keatas (nilai positif) dan kebawah 

bernilai negatif. Lebih jelasnya lihat gambar dibawah ini. 

 

Gambar 3.2 Sumbu global yang sesuai dengan kaidah tangan kanan 

Sumber: fendypermana.blogspot.com 

3.2.2.   Sistem Koordinat 
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b. Sumbu lokal 

Pada orientasi default SAP2000 koordinat lokal terdapat 3 garis yang saling 

tegak lurus, sumbu lokal 1 berwarna merah. sumbu lokal 2 berwarna putih. 

sumbu lokal 3 berwarna biru. 

 
 

Gambar 3.3 Sumbu lokal 

Sumber: fendypermana.blogspot.com 

Berikut beberapa ketentuan dalam sumbu lokal: 

1) Orientasi sumbu lokal 1 arahnya selalu memanjang arah / element frame, 

dimana arah positif ialah dari ujung "i" ke ujung "j". 

2) Orientasi default sumbul lokal 2 dan 3 ditentukan oleh hubungan sumbu 

lokal 1 dan sumbu global Z sebagai berikut 

a) jika sumbu lokal 1 arahnya horizontal, maka arah sumbu lokal 2 sejajar 

dengan sumbu global z, 

b)  jika sumbu lokal 1 arahnya keatas (z+), maka arah sumbu lokal 2 

sejajar dengan sumbu global x(-), dan 

c) sumbu lokal 3 arahnya selalu horizontal tegak lurus bidang X-Y. 

3) Untuk arah putaran momen atau puntir, juga berlaku kaidah tangan kanan 

seperti pada gambar 2.4 di bawah ini. Rotasi positif ialah searah jarum jam 

apabila sumbu 1 menjahi arah pengamat. Gambar dibawah ini untuk 

memperjelas uraian di atas, terlihat arah sumbu X menjauhi pengamat. 
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Gambar 3.4 Kaidah tangan kanan putaran momen atau torsi 

Sumber: fendypermana.blogspot.com 

Elemen dasar yang digunakan untuk pemodelan SAP2000 adalah: 

a. Joint (titik nodal), berupa elemen titik/nodal, 

b. Frame (batang), berupa elemen garis (1D), 

c. Area, merupakan elemen luasan (2D), dan 

d. Solid, merupakan elemen ruang (3D). 

 

Dalam memilih elemen (joint, frame, area, solid), SAP2000 menyediakan 

beberapa cara berikut: 

a. Klik atau pilih langsung elemen yang diinginkan. 

b. Cara windowing (melingkupi elemen yang dimaksud). 

c. Lewat menu select, atau beberapa jenis pilihan yang tersedia pada toolbar. 

Untuk cara yang pada point b, elemen yang akan dipilih diliputi dengan cara 

klik kiri tombol mouse, lalu tahan dan geser (drag) sampai terbentuk kotak garis 

putus-putus yang akan melingkupi elemen yang dimaksud, kemudian dilepas. 

Perlu diperhatikan bahwa arah lingkupan memberikan hasil berbeda, yaitu : 

3.2.3.   Objek dan Elemen 

3.2.4.   Pemilihan Elemen dan Assignment 
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1) Windowing dari arah kiri ke kanan, akan memilih elemen yang dilingkupi 

kotak saja, 

2) Windowing dari arah kanan ke kiri, akan memilih semua elemen yang 

terkena kotak. 

Sedangkan untuk cara pada point c, lewat menu select > select > …), dapat 

dipilih elemen-elemen tertentu saja, berdasarkan jenis elemen, tipe penampang, 

dll. Untuk beberapa jenis pilihan tertentu, ada toolbar yang tersedia, yaitu : 

1) untuk memilih seluruh elemen: , 

2) untuk memilih elemen terakhir yag telah dipilih sebelumya: , dan 

3) untuk menghilangkan pilihan :  (atau tekan Esc pada keyboard). 

Untuk proses assignment, seperti penggantian tipe penampang, pemasukan 

beban, dll, urutannya adalah 

1) Pemilihan elemen yang dimaksud dengan metode yang diinginkan, 

2) Assignment pada elemen yang dimaksud. 

Dengan demikian, misal untuk mengganti tipe tumpuan nodal, maka yang 

harus dilakukan adalah memilih joint yang dimaksud terlebih dahulu, kemudian 

mengganti restraint lewat menu Assign > Joint > Restraint dan memilih jenis 

tumpuan yang sesuai. 

Sebelum melakukan pemodelan struktur, terlebih dahulu buka program 

SAP2000. Setelah program terbuka, selanjutnya dilakukan pembuatan file baru, 

pemilihan satuan dan template, dan pembuatan garis bantu (grid). Jika langkah- 

langkah tersebut dilakukan, selanjutnya dilakukan pemodelan struktur. 

Pembuatan File baru dapat dilakukan dengan beberapa cara, yaitu: 

3.3. Langkah-langkah Pemodelan Struktur 

3.3.1.  Membuat File Baru 
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a. klik menu File > New Model… 
 

Gambar 3.5 Menu File 

b. klik perintah  pada toolbar, atau 

c. kombinasi Ctrl+N pada keyboard. 

Pemilihan satuan sangat penting dilakukan dalam proses input dan output, 

sehingga wajib diperhatikan sebelum melakukan pemodelan struktur cek terlebih 

dahulu satuan yang akan digunakan karena akan mempengaruhi hasil analisis 

struktur pada langkah selanjutnya. Kemudian pilih template yang akan digunakan 

dalam pemodelan struktur. Dalam praktikum statika ini biasanya dipakai template 

Blank atau Grid Only. 

Gambar 3.6 Kotak dialog New Model 

 

Pembuatan garis bantu ini dimaksudkan agar memudahkan dalam 

pemodelan. Perintah-perintah yang digunakan adalah sebagai berikut. 

3.3.2.   Memilih Satuan dan Template 

3.3.3.  Membuat Grid (Garis Bantu) 
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a. Klik kanan pada lembar kerja, pilih Edit Grid Data 
 

Gambar 3.7 Pilih Edit Grid Data 

b. Kemudian akan muncul tampilan seperti di bawah ini: 
 

 

Gambar 3.8 Kotak dialog Coordinate/Grid Systems 

c. Untuk membuat grid baru, klik Add New System, untuk menduplikat grid yang 

telah ada, klik Add Copy of System, untuk mengubah grid yang telah ada, klik 

Modify/Show System. Masukan data pada Defin Grid System Data, masukan 

data sesuai kebutuhan. 

 

Gambar 3.9 Kotak dialog Define Grid System Data 
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d. Masukan data seperti di bawah ini: 

1) pada bagian grid, isi bebas, bisa dengan abjad atau angka, 

2) ordinate berarti point-point yang diambil dari titik 0 dan sesuai sumbu. 

e. Kemudian klik OK sampai kembali kepada layar kerja windows, maka akan 

tampak garis bantu. 

 
Gambar 3.10 Tampilan lembar kerja setelah dibuat garis bantu (Grid) 

(lembar kerja dalam tampilan 3D) 

Sebelum beban dimasukkan dalam pemodelan, terlebih dahulu ditentukan 

jenis pembebanannya. Perintah-perintah yang digunakan adalah sebagai berikut. 

a. Klik menu Define > Load Patterns…. 
 

Gambar 3.11 Menu Define 

3.3.4.   Menentukan Jenis Pembebanan 
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b. Setelah muncul kotak dialog Define Load Patterns. Buatlah Load Pattern baru 

dengan nama BEBAN pada Load Pattern Name dan tipe beban pilih 

OTHER(pilih pada tab Type). 

c. Isikan angka nol (0) pada Self Weight Multiplier karena dalam statika hanya 

menghitung reaksi perletakan dan gaya dalam akibat dari pembebanan (gaya 

luar) saja sehingga tidak perlu menambahkan berat baloknya sendiri. 

d. Kemudian klik Add New Load Pattern dan klik OK. 
 

Gambar 3.12 Kotak dialog Define Load Patterns 

Pemodelan struktur diawali dengan megggambar frame dengan mengikuti 

garis bantu (grid) dengan cara sebagai berikut. 

a. Klik menu Draw > Draw Frame/Cable/Tendon (bisa juga melalui perintah di 

toolbar). 
 

 

Gambar 3.13 Menu Draw 

3.3.5.   Menggambar Frame 
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b. Kemudian gambarkan frame sesuai dengan kebutuhan dengan mengikuti garis 

bantu yang sudah dibuat. Klik ujung garis bantu kemudian hubungkan dengan 

ujung lain sesuai pola. 

Gambar 3.14 Frame yang telah selesai dibuat (lembar kerja dalam tampilan 

X-Z Plane) 

3.3.6. Memberi Tumpuan 

Setelah menggambarkan frame, perlu adanya tumpuan yang berfungsi untuk 

memberikan reaksi terhadap pembebanan (gaya luar) agar tetap setimbang. 

Langkah-langkahnya yaitu: 

a. Klik joint yang akan diberikan tumpuan. 

 

Gambar 3.15 Tampilan Frame yang akan diberi tumpuan 
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b. Kemudian klik menu Assign > Joint > Restraints. 
 

Gambar 3.16 Menu Assign 

c. Kemudian pilih tumpuan pada bagian Fast Restraint di jendela Joint Restraint. 
 

Gambar 3.17 Kotak dialog Joint Restraints 

d. Kemudian klik OK, maka tumpuan telah di input di joint tersebut. 

 
3.3.7. Memberi Beban 

Langkah selanjutnya adalah pembebanan (pemberian gaya luar) yaitu 

dengan cara sebagai berikut. 
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a. Klik frame yang akan diberikan pembebanan 
 

Gambar 3.18 Tampilan Frame yang akan diberi beban 

b. Kemudian klik Assign >Frame Load , kemudian pilih jenis beban tersebut. 

(Apabila beban titik, maka pilih Point.., apabila beban merata, maka pilih 

Distributed.. ) 

Gambar 3.19 Menu Assign 

c. Apabila bebannya titik, maka pilih Point, maka akan muncul jendela Frame 

Point Loads. 

1) Pada Load Pattern Name, yaitu beban mati (DEAD) 

2) Cek satuan pada bagian Units 

3) Pilih jenis bebannya pada Load Pattern Name sesuai yang sudah dibuat. 
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4) Pilih beban yang akan bekerja, apakah berupa gaya atau momen pada Load 

Type and Direction. 

5) Bagian direction untuk menentukan arah dari gaya/beban tersebut. 

6) Pada bagian Options, add berarti memasukkan atau menambah gaya, 

Replace berarti mengganti gaya/beban, dan Delete berarti untuk menghapus 

gaya yang ada. 

7) Isikan letak dan besar pembebanan pada bagian Point Loads. 

8) Relative Distance from End-I berarti jarak yang digunakan yaitu jarak relatif 

dari titik awal ke titik akhir (bernilai 0-1) 

9) Absolute Distance from End-I berarti jarak yang digunakan yaitu jarak 

sebenarnya dari titik awal ke titik akhir. 

 

Gambar 3.20 Kotak dialog Frame Point Loads 

d. Setelah isian pada jendela Frame Point Load di isi, kemudian klik OK, maka 

beban akan muncul. 

 

Gambar 3.21 Tampilan Frame yang sudah diberi beban titik 
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e. Apabila beban merata, maka klik terlebih dahulu frame-nya, kemudian klik 

Assign >Frame Loads > Distributed.., maka akan muncul jendela Frame 

distribution Loads. 

f. Cara input beban untuk beban merata hampir sama dengan cara input beban titik 

yang telah dibahas. Untuk beban merata di input di Uniform load atau di 

Trapezoidal Loads. Uniform Load merupakan input beban merata untuk semua 

frame yang dipilih, dan trapezoidal loads untuk input beban merata di sebagian 

frame atau beban tidak merata (seperti beban segitiga). 

 

Gambar 3.22 Kotak dialog Frame Distributed Loads 

g. Setelah semua data beban telah di input-kan, klik OK. Maka beban akan muncul 

di pemodelan. 

h. Beban merata yang telah dibuatkan akan    ditampilkan pada lembar kerja 

dan beban titik menjadi menghilang, padahal hanya disembunyikan. Agar beban 

titik muncul kembali dengan cara klik perintah pada toolbar, maka akan muncul 

jendela Show Frame Load. 

i. Kemudian klik OK, maka beban titik yang tadi tersembunyi akan muncul. 
 

Gambar 3.23 Tampilan Frame yang sudah diberikan pembebanan 
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j. Cara di atas apabila arah nya merupakan arah gravitasi atau arah vertikal ke 

bawah, apabila arahnya horizontal, maka caranya adalah sebagai berikut: 

1) Klik frame yang akan diberi pembebanan. 

2) Klik Assign >Frame Loads > Point (Karena yang akan di input merupakan 

beban titik, maka dipilih Point), maka akan muncul jendela Frame Point 

Load. 

3) Struktur Balok akan diberi beban tekan sejajar dengan sumbu X, maka pada 

bagian direction, ganti menjadi X. Apabila nilai beban positif, maka arahnya 

searah dengan sumbu X, apabila nilai beban negative, maka arahnya 

berlawanan arah dengan sumbu X. 

4) Isi jendela Frame Points Loads sesuai dengan gambar di bawah ini 
 

Gambar 3.24 Kotak dialog Frame Points Loads 

k. Klik OK. maka beban akan muncul dengan arah yang kita tentukan. 
 

Gambar 3.25 Tampilan Frame dengan beban titik horizontal 
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l. Pada stuktur gerber terdapat sambungan sendi, untuk memodelkan sambungan 

tersebut pilih Frame yang akan dijadikan sambungan. Kemudian pilih menu 

Assign > Frame > Releases/Partial Fixie… 

Gambar 3.26 Tampilan Frame dengan beban titik horizontal 

m. Setelah muncul kotak dialog Assign Frame Releases maka centang pada Momen 

33 (Major). Centang pada bagian start/end saja tergantung dimana balok 

tambahan tersebut akan diletakkan. 

 

Gambar 3.27 Tampilan Frame dengan beban titik horizontal 

n. Pada struktur rangka atau truss terdapat batang yang disambung disetiap titiknya, 

sehingga untuk memodelkan sambungan tersebut pilih semua Frame yang akan 

dijadikan sambungan. Kemudian pilih menu Assign > Frame >Release 

/Partial Fixie…, setelah muncul kotak dialog Assign Frame Releases maka 
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centang pada Momen 33 (Major). Centang pada bagian start dan end karena 

batang tersebut disambung di setiap titik. 

 

Gambar 3.28 Tampilan Frame dengan beban titik horizontal 
 

 

Gambar 3.29 Tampilan Frame dengan beban titik horizontal 
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3.4.Langkah-langkah Analisis Struktur 

Setelah frame, tumpuan dan pembebanannya telah selesai di-input, maka 

dilakukan analisis terhadap struktur tersebut. Hasil analisis struktur yang akan 

ditampilkan pada praktikum ini adalah reaksi perletakan dan diagram gaya dalam. 

Analisis Struktur tersebut dilakukan dengan menggunakan perintah dibawah 

ini. 

a. Klik perintah di toolbar,        atau klik menu Analyze > Run Analysis atau 

klik F5 pada keyboard. 

b. Akan muncul jendela Set Load Case to Run 
 

Gambar 3.30 Kotak dialog Set Load Case to Run 

c. Matikan DEAD LOAD dengan cara, klik case DEAD, kemudian klik Run/Do 

Not Run Case, karena kita hanya menghitung pembebanan untuk jenis beban 

yang telah kita buat sebelumnya. 

d. Case MODAL berfungsi untuk analisis dinamis, namun tidak terlalu berpengaruh 

pada pemodelan sederhana seperti pemodelan statika ini, sehingga boleh 

dibiarkan berjalan (run) atau boleh juga dimatikan 

e. Kemudian Klik Run Now, tunggu sampai proses selesai. Apabila proses analysis 

telah berhasil, maka akan muncul deformasi dari pemodelan struktur tersebut. 

f. Setelah proses analisis, kita juga akan memperoleh reaksi perlatakan dan gaya 

dalam, dari perancangan sturktur tersebut. 

3.4.1.   Run Analysis 
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Gambar 3.31 Tampilan Deformed Shape 

 

Reaksi perletakan dapat diketahui menggunakan perintah dibawah ini. 

a. Klik Display > Show Forces/Stersses > Joints. 
 

 

Gambar 3.32 Menu Display 

b. Akan muncul jendela Joint Reaction Forces, centang pada Show Result as 

Arrows agar terlihat arah reaksi. 

c. Klik OK. 
 

 

Gambar 3.33 Tampilan Reaksi perletakan (Joint Reactions) 

3.4.2.   Melihat Reaksi Perletakan 
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Diagram Gaya dalam dapat diketahui menggunakan perintah dibawah ini. 

a. Klik Menu Display > Show Forces/Stersses >Frames/Cables… 
 

Gambar 3.34 Menu Display 

b. Akan muncul jendela Member Force Diagram for Frames 
 

Gambar 3.35 Kotak dialog Member Force Diagram for Frames 

c. Pada bagian component, pilih Axial Force untuk NFD, Shear 2-2 untuk SFD 

dan Moment 3-3 untuk BMD. 

3.4.3.   Melihat Diagram Gaya Dalam 
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d. Setelah di klik OK, maka akan ada tampilan sebagai berikut: 

1) Axial Force (NFD) 
 

Gambar 3.36 Tampilan Axial Force Diagram 

2) Shear 2-2 (SFD) 
 

Gambar 3.37 Tampilan Shear 2-2 Diagram 

3) Moment 3-3 (BMD) 

Gambar 3.38 Tampilan Moment 3-3 Diagram 



 

 

BAB IV. SIMPLE BEAM 

 
 

Simple Beam (Balok sederhana) adalah balok yang ditumpu oleh tumpuan 

sendi pada salah satu ujungnya, dan tumpuan rol pada ujung lainnya. Contoh 

aplikasi struktur balok sederhana adalah jembatan sederhana yang menggunakan 

tumpuan sendi pada salah satu ujungnya dan tumpuan rol pada ujung lainnya. 

Pengujian ini bertujuan untuk menentukan nilai reaksi perletakan yang 

dihasilkan dari beban yang diberikan pada struktur simple beam. 

a. Pemberat 

b. Timbangan 

c. Alat Pengukur (meteran) 

a. Atur dan susun rangka batang dan tumpuan sesuai dengan struktur simple 

beam. 

b. Pasang dan atur pengait beban dengan jarak yang sudah ditentukan sesuai 

dengan pembebanan struktur. 

c. Lakukan kalibrasi timbangan setelah semua tersusun sesuai dengan struktur 

simple beam. 

d. Letakkan pemberat dengan berat yang sudah ditentukan pada pengait beban. 

e. Baca dan catat reaksi perletakan yang dihasilkan pada timbangan. 

Diketahui sebuah balok sederhana seperti gambar dibawah ini, hitung reaksi 

perletakan dan gaya dalam yang bekerja pada balok. 
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4.1.   Pendahuluan 

4.2.     Tujuan 

4.3.      Alat 

4.4.      Cara Pengujian 

4.5.   Perhitungan 
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Gambar 4.1 Contoh soal balok sederhana 

Jika diuraikan gaya-gayanya, maka akan menjadi gambar dibawah ini. 
 

Gambar 4.2 Uraian gaya-gaya dalam perhitungan 

 
Px = P cos300 Py = P sin300 

= 10 cos300  = 10 sin300 

= 8,667 kN  = 5 kN 

 

∑MC = 0 

RAV.(6+4)– Py.(4) = 0 

RAV.(10)– 5.(4) = 0 

RAV.(10)– 20 = 0 

RAV = 2 Kn 

∑MA = 0 

Py.(6)– RCV.(6+4)= 0 

5.(6)– RCV.(10) = 0 

30– RCV.(10) = 0 

RCV = 3 kN 

 

Kontrol 

∑V= 0 

RAV +RCV – Py = 0 

2 + 3 – 5 = 0 …(OK) 

∑H= 0 

RAH +Px = 0 

RAH = – Px 

RAH = – 8,667 kN 

4.5.1.   Reaksi Perletakan 
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a. NFD 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 

NA = –RAH 

= –(–8,667) 

= 8,667 kN 

NB = –RAH 

= –(–8,667) 

= 8,667 kN 

NC =0 kN 

(Balok tersebut mengalami tarik dari titik A sampai B) 

b. SFD 

VA = RAV 

= 2 kN 

VB = VA – Py 

= 2 – 5 

= -3 

VC = VB + RCV 

= –3 + 3 

= 0 kN 

 

 
 

c. BMD 

MA = 0 kNm 

MB = RAV.(6) 

= 2.(6) 

= 12 kNm 

MC = [RAV.(6+4)] – (Py.4) 

= 2.(10) – (5.4) 

= 0 kNm 

4.5.2.  Gaya-gaya dalam 
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4.5.3. Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 
 

Gambar 4.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 



 
 

BAB V. SIMPLE BEAM OVERHANG 

 
 

Balok menggantung (beam overhanging) merupakan balok sederhana yang 

salah satu sisinya memanjang/berlebih melewati kolom tumpuannya. Sehingga 

balok tersebut seperti menggantung di salah satu sisinya. Konsep perhitungan dari 

simple beam overhang ini hampir sama dengan dengan konsep pada balok 

sederhana. 

Penerapan simple beam overhang di lapangan biasanya adalah untuk 

penopang atau dudukan panel lantai. 

Diketahui sebuah beam cantilever seperti gambar dibawah ini, tentukan reaksi 

perletakan, dan gaya normal yang bekerja pada struktur dibawah ini. 

 

Gambar 5.1 Contoh soal simple beam overhang 

 
 

Jika diuraikan gaya-gayanya, maka akan menjadi gambar dibawah ini. 
 

Gambar 5.2 Uraian gaya-gaya dalam perhitungan 
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5.1.   Pendahuluan 

5.2.   Perhitungan 
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∑MB = 0 ∑MA= 0 

RAV.(8)– R.(0,5.8)– P1.(4)+P2.(2) = 0 

RAV.(8)– 800.(4)– 50.(4) +40.(2) = 0 

RAV.(8)– 3200– 200 + 80 = 0 

RAV.(8)= 3320 

RAV = 415 kN 

–RBV.(8)+R.(0,5.8)+P1.(4)+P2.(10)=0 

–RBV.(8)+800.(4)+ 50.(4)+40.(10)=0 

–RBV.(8)+ 3200+ 200 + 400 = 0 

–RBV.(8)= –3800 

RBV = 475 kN 

 

Kontrol 

∑MB = 0 

RAV + RBV – R– P1 – P2 = 0 

415+ 475 – 800– 50– 40 = 0 (OK) 

 
∑H= 0 

 

RAH = 0 

 
 

a. NFD 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 
 

N = - RAH 

= 0 

(Tidak ada gaya aksial yang bekerja pada balok) 

b. SFD 

VA = RAV 

= 415 Kn 

Vc = VA - q.(4) 

= 415 – 100.(4) 

= 15 kN 

 

c. BMD 

VC’ = VC – P1 VB’ = VB+ RBV 

= 15 – 50 = –435 + 475 

= –35 kN = 40 kN 

VB = VC’– q.(4) VD = VB’ – P2 

= –35 – 100.(4) = 40 – 40 

= –435 kN = 0 kN 

 

 

5.2.1.   Reaksi Perletakan 

5.2.2.   Gaya-gaya dalam 
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Gambar 5.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 

5.2.3.   Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 



 
 

BAB VI. KANTILEVER 

 
 

Kantilever merupakan balok yang terjepit pada salah satu ujungnya (terdapat 

tumpuan jepit) sedangkan ujung lainnya bebas tanpa ditumpu oleh tumpuan lain. 

Tumpuan jepit mampu menahan gaya dari berbagai arah dan menahan momen, 

sehingga terdapat 3 variabel reaksi yang harus di cari dalam struktur balok 

kantilever, yaitu RAH, RAV, dan MA (apabila tumpuan jepit di titik A). Penerapan 

balok kantilever biasanya digunakan untuk balkon, dinding penahan tanah, dan lain- 

lain. 

Diketahui sebuah kantilever seperti gambar dibawah ini, tentukan reaksi 

perletakan dan gaya-gaya dalam yang bekerja pada struktur tersebut. 

 

Gambar 6.1 Contoh soal kantilever 

 

Jika diuraikan gaya-gayanya, maka akan menjadi gambar dibawah ini. 
 

Gambar 6.2 Uraian gaya-gaya dalam perhitungan 
 

Px = P cos30o Py = P sin30o R = 8 sin30o 

= 8 cos30o 

= 6,93 kN 

 = 8 sin30o 

= 4 kN 

= 2 . 4 

= 8 kN 
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6.1.   Pendahuluan 

6.2.   Perhitungan 
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∑V= 0 

 

∑MA= 0 

RAV – R – Py = 0 MA+ R.(0,5.4)+ Py.(4) = 0 

RAV = R + Py MA + 8.(2)+ 4.(4) = 0 

RAV = 8 + 4 = 12 kN MA =–16 – 16 = –32 kN 

 
 

Kontrol ∑H= 0 

∑MB = 0 

MA + RAV.(4)+ R.(0,5.4) = 0 

RAH – Px = 0 

RAH = Px 

–32 + 12.(4) – 8.(2) = 0 …(OK) RAH = 6,93 kN 
 
 

a. NFD 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 

NA = – RAH 

= – 6,93 kN 

NB = – RAH 

= – 6,93 kN 

 

 

(Balok tersebut mengalami tekan di seluruh bentang) 

b. SFD 

VA = RAV 

= 12 kN 

VB = VA – R 

= 12 – 8 

= 4 kN 

 

 

6.2.1.   Reaksi Perletakan 

6.2.2.   Gaya-gaya dalam 
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Gambar 6.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 

6.2.3.   Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 



 

 

BAB VII. GERBER 

 
 

Balok gerber merupakan konstruksi balok di atas beberapa tumpuan, yang 

merupakan gabungan konstruksi balok menggantung (beam cantilever) yang 

disambungkan dengan balok lain. Balok menggantung yang terlalu panjang akan 

menyebabkan terjadinya momen lentur yang terlalu besar, sehingga perlu diambah 

dengan konstruksi balok lain. Hal ini menyebabkan kontruksi tersebut menjadi 

struktur statis tak tentu (lihat persamaan 1.4). Agar sifat konstruksi itu kembali 

menjadi statis tertentu maka digunakan sambungan sendi. 

Diketahui sebuah balok gerber seperti gambar dibawah ini, tentukan reaksi 

perletakan dan gaya-gaya dalam yang bekerja dalam balok tersebut. 

 

Gambar 7.1 Contoh soal balok gerber 
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7.1.   Pendahuluan 

7.2.   Perhitungan 
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a. Tinjau batang S-E untuk mengetahui nilai REV dan VS. 
 

 

 
∑MS = 0 

REV.(2 + 3)– P.(2)= 0 

REV.(5)– 20.(2)= 0 

REV.(5)– 40= 0 

REV.(5)= 40 

REV = 8 kN 

Kontrol batang S-E 

∑V= 0 

REV + RS – P = 0 

8 + 12 – 0 = 0 ..(OK ) 

Gambar 7.2 Tinjauan batang S-E 

∑MB = 0 

RS.(2 + 3)– P.(3)= 0 

RS.(5)– 20.(3)= 0 

RS.(5)– 60= 0 

RS.(5)= 60 

RS = 12 kN 

7.2.1.   Reaksi Perletakan 
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b. Tinjau batang A-C-S untuk mengetahui nilai RAV dan RCV. 

 

 

 
∑MC = 0 

Gambar 7.3 Tinjauan batang A-C-S 

∑MA= 0 

 

RAV.(3 + 3)– P.(3)+ RS.(2) = 0 

RAV.(6)– 20.(3)+ 12.(2) = 0 

RAV.(6)– 60 + 24= 0 

RAV.(6)= 36 

RAV = 6 kN 

Kontrol batang A-C-E 

∑V= 0 

RAV + RCV+ REV+ P – P = 0 

6 + 26 + 8 – 20 – 20 = 0 ...(OK) 

P.(3)– RCV.(3 + 3)+ RS.(3+3+2)= 0 

20.(3)– RCV.(6)+ 12.(8)= 0 

60– RCV.(6)+ 96= 0 

– RCV.(6)= –156 

RCV = 26 kN 

∑H= 0 

RAH = 0 

 

a. NFD 
 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 

N = –RAH 

= 0 

(Tidak ada gaya aksial yang bekerja pada balok) 

b. SFD 
 

VA = RAV VC = VB +RCV 

= 6 kN 

VB = VA – P 

= 6 – 20 

 = –14 + 26 

= 12 kN 

= –14 kN 

7.2.2.   Gaya-gaya dalam 
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VD = VC – P 

= 12 – 20 

= – 8 kN 

VE = VD + REV 

= –8 + 8 

= 0 kN 

 

 

 

 

c. BMD 

MA = 0 kNm 

MB = RAV.(3) 

= 6.(3) 

= 18 kNm 

MC = RAV.(3+3) – P.(3) 

= 6.(6) – 20.(3) 

= – 24 kNm 

MD =RAV.(3+3+2+2) – P.(3+2+2) 

+ RCV.(2+2) 

= 6.(10) – 20.(7) + 26.(4) 

= 24 kNm 

ME = RAV.(3+3+2+2+3) – 

P.(3+2+2+3) + RCV.(2+2+3) 

– P. (3) 

= 6.(13) – 20.(10) + 26.(7) – 

20.(3) 

= 0 kNm 
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Gambar 7.4 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 

7.2.3.  Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 



 

BAB VIII. PORTAL 2D 

 
 

Portal adalah suatu sistem yang terdiri dari bagian-bagian struktur yang saling 

berhubungan yang berfungsi menahan beban sebagai suatu kesatuan lengkap yang 

berdiri sendiri dengan atau tanpa dibantu oleh diafragma-diafragma horizontal atau 

sistem-sistem lantai. Bangunan portal banyak dijumpai sebagai konstruksi bangunan 

gudang, hangar dan jembatan. 

8.2. Perhitungan 

Diketahui sebuah portal seperti gambar 7.1 di bawah ini, tentukan reaksi 

perletakan dan gaya- gaya dalam yang bekerja pada struktur tersebut. 
 

 
Gambar 8.1 Contoh soal portal 

 
Jika diuraikan gaya-gayanya, maka akan menjadi gambar di bawah ini. 

 

 

 

Gambar 8.2 Uraian gaya-gaya dalam perhitungan 
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8.1. Pendahuluan 



 

ΣMB = 0 

8Ra – P . 6 = 0 

8Ra – 2 . 6 = 0 

53 

 
 

ΣMA = 0 

8Rb – P . 2 = 0 

8Rb – 2 . 2 = 0 

4 
12 

Ra = 
8 = 1,5 T 

Rb = 
8 

= 0,5 T 

 

 

 

 

 

Kontrol 

Σ MV = 0 

Ra + Rb – P = 0 

1,5 + 0,5 - 2 = 0 

 

a. NFD 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 

NAC = – RAV 

= – 1,5 T 

NBD = – RBV 

= – 0,5 T 

 
 

(Balok tersebut mengalami tekan di seluruh bentang) 

b. SFD 

DA = 0 Ton 

DC = RAV 

= 1,5 T 

 

 

 

 

 
c. BMD 

MA = 0 Tm 

MC = 0 Tm 

DE = RAV – P 

= 1,5 - 2 

= 0,5 T 

DD = RAV – P + RBV 

= 1,5 – 2 + 0,5 

= 0 T 

 

 

ME = RAV . 2 

= 1,5 . 2 = 3 Tm 

MD = RAV . 8 – P . 6 

= 1,5 . 8 – 2 . 6 = 0 Tm 

MB = 0 Tm 

8.2.1.  Reaksi Perletakan 

8.2.2.  Gaya-gaya dalam 
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8.2.3. Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 
 

 

 

Gambar 8.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 



 

 

BAB IX. RANGKA BATANG (TRUSS) 

 
 

Dalam melakukan analisis suatu struktur rangka batang terlebih dahulu harus 

ditetapkan suatu aturan perjanjian tanda. Dalam struktur rangka batang, setiap 

batang diasumsikan hanya memikul gaya aksial, sehingga hanya dimungkinkan 

timbul gaya aksial tekan atau gaya aksial tarik. Arah gaya pada masing-masing 

batang digambarkan sebagai tanda panah yang berpusat pada suatu titik kumpul. 

Gaya aksial tarik digambarkan sebagai satu anak panah yang berarah keluar dari 

titik kumpul (meninggalkan joint) dan diberi tanda positif (+), sedangkan gaya 

aksial tekan digambarkan sebagai suatu anak panah yang berarah masuk ke dalam 

titik kumpul (menuju joint) dan diberi tanda negatif (-). 

Selanjutnya untuk menentukan besaran gaya batang harus dilakukan analisis 

struktur, ada beberapa metode analisis struktur yang sering digunakan. Tiap metode 

dapat digunakan tergantung keperluan atau tujuan analisisnya. Dalam modul ini 

akan dibahas mengenai Metode Titik Kumpul (Method of Joints) dan Metode 

Cremona. Kemudian dari kedua metode tersebut nantinya akan dibandingkan 

dengan hasil dari pemodelan menggunakan program SAP2000. 

Metode ini merupakan metode dasar yang dapat digunakan untuk 

menganalisis suatu struktur rangka batang. Apabila diperlukan untuk mengetahui 

seluruh nilai gaya batang, maka dapat digunakan metode joint ini. Metode ini 

dilakukan dengan cara meninjau syarat kesetimbangan gaya di setiap titik kumpul, 

menggunakan persamaan H = 0 dan V = 0. Pada titik kumpul (joint) yang ditinjau, 

dapat digambarkan semua gaya batang yang ada beserta gaya-gaya luar yang bekerja 

pada joint tersebut, termasuk reaksi tumpuan bila ada. Sebagai asumsi awal, semua 

gaya batang yang digambarkan pada tiap joint dapat digambar sebagai suatu gaya 

tarik (meninggalkan joint). Jika pada saat analisis diperoleh hasil negatif, berarti arah 

gaya tersebut berlawanan dengan arah gaya asumsi awal. 

 

 

 

 

 
55 

9.1.    Pendahuluan 

9.2.    Metode Titik Kumpul (Method of Joints) 
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Langkah pertama untuk melakukan metode ini adalah dengan menghitung 

reaksi perletakan terlebih dahulu. Selanjutnya perhitungan gaya batang dengan 

metode ini dapat dimulai pada joint yang hanya memiliki maksimum dua buah 

batang yang tidak diketahui dan diasumsikan meninggalkan joint (diasumsikan 

tarik). Biasanya dapat dimulai pada titik tumpuan. Analisis dapat dilanjutkan pada 

tiap joint, hingga seluruh gaya batang dapat dihitung besarnya. 

Diketahui sebuah stuktur rangka atap seperti gambar dibawah ini, hitunglah 

reaksi perletakan dan gaya dalam yang bekerja pada struktur tersebut. 

Gambar 9.1 Contoh soal rangka batang 

Jika diuraikan gaya-gayanya, maka akan menjadi gambar dibawah ini. 

 

Gambar 9.2 Reaksi perletakan 

9.2.1.  Perhitungan 



 

∑MB = 0 

RAV.(6)– P.(3) = 0 

RAV.(6) – 20.(3) = 0 

RAV.(6) = 60 

RAV = 10 Ton 

Kontrol 

∑V= 0 

RAV + RBV– P = 0 

10 + 10 – 20 = 0 ..(OK) 
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∑MA = 0 

–RBV.(6)+ P.(3) = 0 

–RBV.(6) + 20.(3) = 0 

–RBV.(6) = –60 

RBV = 10 Ton 

 
∑H= 0 

RAH = 0 

 

 

 
 a. Joint A 

 

 

∑V = 0 

Gambar 9.3 Tinjauan di titik A 

∑H = 0 

FAD + FAC.c α = 0 

FAD = –FAC.cos(45) 

FAD= –14,14.cos(45) 

FAD = 10 Ton (Tarik) 

 

 

Jika diperoleh nilai negatif, berarti arah gaya berlawanan dengan arah asumsi awal. 

9.2.2.   Tinjauan gaya batang pada tiap joint 
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b. Joint C 
 

 

 
∑H = 0 

Gambar 9.4 Tinjauan di titik C 

∑V = 0 

 
–FAC.c α FBC.c α = 0 

FBC.c α = FAC.c α 

FBC = FAC 

FBC = –14,14 Ton (Tekan) 

 
 

c. Joint D 

–FAC. α–FBC.   α–P – FCD = 0 

FCD = –(–14,14.sin(45))–(–14,14. 

sin(45)) – 20 

FCD = –(–10) – (–10) – 20 

FCD = 0 Ton 

 

 

 

 
∑H = 0 

–FAD + FBD = 0 

FBD = FAD 

Gambar 9.5 Tinjauan di titik 

FBD = 10 Ton (Tarik) 
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9.2.3. Kesimpulan metode joint 

 

Batang Gaya (Ton) Keterangan 

AC –14,14 Tekan 

AD 10 Tarik 

CD 0 - 

BD 10 Tarik 

BC –14,14 Tekan 

 

Gambar 9.6 Gaya Aksial yang dialami batang 

9.2.4. Perbandingan Gaya Batang dari Metode Joint dengan Program SAP2000 
 

Tabel 9.2 Perbandingan Gaya Batang 
 

Batang Metode Joint 
Program SAP2000 

Gaya (Ton) Error*) 

AC –14,14 –14,14 0 % 

AD 10 10 0 % 

CD 0 0 0 % 

BD 10 10 0 % 

BC –14,14 –14,14 0 % 

*)persentase ketidak tepatan terhadap nilai gaya dari metode joint 

Tabel 9.1 Gaya batang menggunakan metode joint 
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9.3. Metode Cremona 

Metode Cremona adalah metode penyelesaian gaya-gaya batang dengan 

cara grafis. Pemahaman konsep  tentang perhitungan dengan metode ini perlu 

dikuasai. Prinsip dalam perhitungan Metode Cremona yaitu sebagai berikut 

Langkah-langkah: 

1. hitung terlebih dahulu reaksi-reaksi tumpuan 

2. skala perlu diperhatikan sebelum memulai penggambaran. 

3. pada setiap titik buhul maksimum hanya ada 2 gaya yang belum diketahui, 

biasanya penggambaran gaya batang dimulai dari titik tumpuan (perletakan). 

4. penggambaran gaya batang diurutkan searah jarum jam. 

5. besarnya gaya batang berprinsip bahwa resultan seluruh gaya luar dan gaya 

dalam sama dengan 0. 

6. penggambaran arah gaya batang harus sejajar batang yang dihitung 

gayanya. 

7. gaya yang arahnya meninggalkan titik buhul adalah batang tarik, 

sedangkan gaya yang arahnya menuju titik buhul adalah batang tekan. 

8. penggambaran gaya harus membentuk sebuah polygon tertutup yang 

membentuk sebuah siklus, dan 

9. besarnya gaya tiap batang dibuatkan dalam tabel dan kemudian perhitungan 

tersebut disimpulkan. 
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Langkah pertama sama seperti metode joint yaitu terlebih dahulu dicari reaksi 

perletakannya, sehingga didapat nilai RAV dan RBV sebesar 10 Ton seperti gambar di 

bawah ini. 

 

Gambar 9.7 Nilai reaksi perletakan 

Selanjutnya   membuat   daftar   kontruksi   gaya   batang   yang    ada   pada titik 

buhul untuk mengetahui gaya batang yang sudah diketahui dan yang akan dicari nilai 

gayanya. 

Buatlah tabel seperti Tabel 8.3 di bawah ini, tanda kurung pada kolom gaya 

adalah gaya yang sudah diketahui nilainya sedangkan yang tidak dikurung adalah 

gaya yang akan dicari nilainya. Sepakati juga tentang arah penggambaran gayanya, 

pada praktikum ini penggambaran gayanya searah jarum jam. 

Tabel 9.3 Daftar kontruksi gaya batang 

9.3.1.Perhitungan 
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Titik A 
 

 

 
 

Titk D 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 9.8 Gaya batang pada titik A 

 

 
 

 

 
 

Titik C 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 9.9 Gaya batang pada titik D 

 

 
 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 9.10 Gaya batang pada titik C 
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Titik B 
 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 9.11 Gaya batang pada titik B 

Gabungan dari semua gaya 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 9.12 Gabungan gaya batang 

Tabel 9.4 Gaya batang menggunakan metode cremona 

9.3.2.   Kesimpulan Metode Cremona 
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(Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg) 

Gambar 9.13 Gaya Aksial yang dialami batang 

9.3.3. Perbandingan Gaya Batang dari Tiga Metode 

Tabel 9.5 Perbandingan Gaya Batang dari Tiga Metode 
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9.4. Metode Potongan (Method of Ritter) 

Pada metode ini, penentuan besarnya gaya-gaya batang dilakukan dengan 

menganalisis potongan yang dibuat oleh garis fiktif yang memotong maksimum 3 

batang yang belum diketahui gaya batangnya. 

Langkah-langkah: 

1. hitunglah reaksi peletakan dengan menganggap rangka batang sebagai balok 

sederhana di atas dua peletakan. 

2. buatlah garis potongan fiktif dengan pertimbangan garis tersebut hanya 

memotong batang maksimum 3 batang yang belum diketahui gaya batangnya. 

3. peninjauan potongan hanya pada salah satu bagian atau sisi saja (freebody kiri 

atau freebody kanan), karena peninjauan freebody kiri maupun freebody kanan 

akan menghasilkan besar gaya dan arah gaya yang sama. 

4. seluruh gaya batang yang dicari, gaya-gaya luar (beban) dan reaksi peletakan 

harus diperhitungkan, demikian pula jarak joint dari batang yang terpotong 

harus tergambarkan. 

5. gaya batang yang belum diketahui selalu diumpamakan sebagai gaya tarik / 

positif (+) terlebih dahulu. Bila hasil perhitungannya memberikan hasil negatif 

(-), maka arah gaya batang dapat dibalik tetapi nilainya berubah menjadi positif. 

6. menentukan besarnya gaya batang dengan menghitung jumlah momen pada 

suatu titik tertentu (akibat reaksi, beban luar dan gaya batang pada irisan yang 

ditinjau) harus sama dengan nol → ∑M = 0 

7. buatlah potongan-potongan yang lainnya sehingga semua gaya batang dapat 

ditentukan. 

Beberapa catatan penting tentang cara Ritter : 

1. Metode Ritter dapat dikombinasikan dengan metode Keseimbangan Titik, 

dalam arti setelah mencari beberapa gaya batang dengan menggunakan cara 

Ritter dapat dilanjutkan mencari gaya batang lainnya dengan menggunakan cara 

keseimbangan titik, atau sebaliknya. 

2. Gaya-gaya batang yang terpotong bersama-sama dengan reaksi-reaksi 

peletakan dan beban-beban yang bekerja harus membentuk keseimbangan. 

3. Gaya-gaya batang yang terpotong mewakili beban-beban luar dan reaksi- reaksi 

tumpuan dari bagian potongan yang tidak ditinjau. 
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4. Setiap freebody yang ditinjau dapat dikontrol keseimbangannya, sehingga gaya 

batang yang diperoleh dapat lebih diyakini kebenarannya dibandingkan dengan 

metode Keseimbangan Titik. 

5. Garis fiktif dapat memotong jumlah batang lebih dari tiga buah asalkan gaya 

batang yang belum diketahui paling banyak tiga buah. 

6. Perhitungan gaya-gaya batang yang lainnya harus dilakukan potongan melalui 

gaya-gaya batang yang dicari. 

Contoh: 

Berikut ini contoh dari rangka batang (contoh pertama) yang telah dihitung 

reaksi peletakannya. Perhatikan rangka batang tersebut ! Garis fiktif x-y memotong 

maksimum 3 batang yang tidak diketahui gaya batangnya, yaitu S1, S3, dan S7. 

Kemudian dilakukan pemisahan potongan pada garis fiktif tersebut, yaitu freebody 

kiri dan freebody kanan. 

 

 

 

Gambar 9.14 Gaya Aksial yang dialami batang 

9.4.1.   Perhitungan 
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Karena konstruksi dan bebannya simetris maka besar RA dan RB sama 

yaitu sama dengan setengah dari jumlah bebannya 

 
 

 

Gambar 9.15 Penyelesaian Potongan A-A 
 

 

Gambar 9.16 Penyelesaian Potongan B-B 
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Gambar 9.17 Penyelesaian Potongan 
 

 

 

Gambar 9.18 Penyelesaian Potongan C-C 
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BAB X. GARIS PENGARUH 

 
 

 Garis pengaruh merupakan grafik yang menunjukkan besarnya pengaruh dari suatu 

satuan beban untuk setiap perubahan kedudukan. Konstruksi pada umumnya dan jembatan 

pada khususnya mendukung beban yang bergerak. Kedudukan beban tersebut selalu 

berubah-ubah, sehingga pengaruhnya pada setiap tampang konstruksi akan selalu 

berubah-ubah pula. Maka perlu diketahui posisi yang bagaimana yang akanmenimbulkan 

maksimum. Untuk keperluan ini kita mempergunakan GARIS PENGARUH. 

Diketahui konstruksi jembatan dilalui oleh beban bergerak P maka pada suatu titik 

tertentu (misal titik C) pada gelagar memanjang akan terdapat gaya- gaya dalam seperti 

gaya lintang dan momen yang berubah besarnya sesuai dengan letak beban bergerak 

pada saat itu, lihat gambar 9.1 berikut. 

  
 

Gambar 10.1 Contoh soal garis pengaruh 

 

Untuk mengetahui berapa sebenarnya besar gaya lintang maksimum dan momen 

maksimum yang mungkin terjadi pada titik C apabila dilalui oleh beban bergerak P, 

maka diperlukan suatu diagram yang disebut Garis Pengaruh. Untuk menggambarkan 

diagram ini digunakan beban bergerak terpusat tunggal dengan nilai P = 1 ton, yang 

diletakkan pada beberapa titik secara bergantian seperti berikut. diuraikan gaya-

gayanya, maka akan menjadi gambar dibawah ini. 

10.2.1. Garis pengaruh RA. 

  P = 1 t berada di A, 

   RA = + P = + 1 (ton) 
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10.1.  Pendahuluan 

10.2.   Perhitungan 
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  P = 1 t berada di C, 

    MB = 0 

   RA = + P . (L-a)/L = + 1 . (L-a)/L (ton) 

  P = 1 t berada di B, 

   RA = 0 (ton) NFD 

10.2.2.   Garis pengaruh RB 

  P = 1 t berada di A, 

   RB = 0 (ton) 

  P = 1 t berada di C, 

    MA = 0 

   RB = + P . a/L = + 1 . a/L (ton) 

  P = 1 t berada di B, 

   RB = + P = + 1 (ton) 

10.2.3. Garis pengaruh gaya lintang pada titik C 

P = 1 t berada di A, Ra = + P = + 1 t, Dc = Ra – P = 0 

P = 1 t berada di C (P belum melewati C), 

 MB = 0 

RA = + P . (L-a)/L = + (L-a)/L (ton) 

Dc = RA – P = P . (L-a)/L – P = P . (L-a)/L – P . L/L = – P . a/L 

Dc = – a/L (ton) 
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P = 1 t berada di C (P sudah melewati C), 

   MB = 0 

  RA = + P . (L-a)/L = + (L-a)/L (ton) 

  Dc = + RA = + P . (L-a)/L = + (L-a)/L (ton) 

10.2.4. Garis pengaruh momen pada titik C 

P = 1 t berada di C, 

   MB = 0 

  Ra = + P . (L-a)/L = + (L-a)/L (ton) 

  Mc = RA . a = P . (L-a)/L . a = a . (L-a)/L (t.m.) 
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